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Meeting programme
Wednesday 30th September 2015
7:30 Monthly Meeting
• Welcome and News
• iOS 9, iPhone, iPad, Watch and Apple TV
• OS X El Capitan
• Questions & Answers
• Supper
Come along and share your passion
for Apple products. Learn about the
latest technology, and enhance your
skills. And meet with old and new
friends over supper.
Visitors welcome.

November Meeting:
Our last meeting of the year will start an hour early - at 6:30pm - with a
pot-luck meal together. Also remember the Photo competition - don’t
wait until the last minute! (See page 4.)

Submitting your article
Electronic submissions are preferred; send to:
editor@appleusers.co.nz
One page is roughly 450 words. Most article are less than 4 pages, but
longer articles may be accepted if of particular interest or relevance.
Please ask in advance if you are planning a longer article.
Please write clearly; short sentences are recommended to help you do
this. Use a spell-checker. If you are quoting some other article, please
include an acknowledgment of your source.
Pictures can help explain your article, so by all means include one (or
more) if appropriate. Provide a high quality image (300 dpi) if possible.
For screen shots, you can use the build-in Apple functions Apple-Shift-3
or Apple-Shift-4, or a utility such as Snapz Pro, available from:
http://www.macdownload.com.

Next Deadline: 12 October 2015
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Photo Competition 2015
SeniorNet Mac - Canterbury Apple Users
Competition categories:
Panoramic
Street
Landscape

Portrait
Pets
Manipulated

A prize will be awarded for each Category including a prize for best
overall photograph
Get your creativity juices flowing now and use your computer, iPhone,
iPad or digital camera and some aspect of photography to create.
Conditions:
You must be a member of SeniorNet Mac.
Only one entry per member per category.
Maximum digital size 5mb.
That the editors of both the Infoletter and the Applebyte have the
rights to publish any photograph submitted in their publications.
All entries will be printed as A4 semi gloss images so that no one person
will have an advantage.
An independent Judge will consider all entries. Entries will be coded so
that the Judge does not know the names of who provided them.
Allan will act as a non-participating coordinator of the competition.
All photographs and results will be on display at the Canterbury Apple
User’s meeting on Wednesday night 25th of November (6.30 - 9.30pm),
at the Functionall Room, Corner of Highsted & Sawyers Arms Roads,
Bishopdale. (Situated behind the shops.)

Deadline: November 18th
“To the complaint, 'There are no people in these photographs,' I respond,
There are always two people: the photographer and the viewer.”
― Ansel Adams
“The camera is an instrument that teaches people how to see without a
camera.”
― Dorothea Lange
“There are no bad pictures; that's just how your face looks sometimes.”
― Abraham Lincoln
“To consult the rules of composition before making a picture is a little
like consulting the law of gravitation before going for a walk.”
― Edward Weston
[Very useful if you walk on the Moon! - Ed]
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Review - Tonality
Frank Petrie
Monochromatic. “adjective; containing or using only one color:
monochromatic light.” Before the technology was available, all film and
photography was rendered in black and white. In film, it saw its heyday
in film noir. As for photography, you need know but one name - Ansel
Adams.
With the advent of color film stock, the art of black and white
photography nearly died. Thanks to a few diehards, it remained on life
support. But done properly and with the right tools, black and white
imagery can be incredibly powerful and astonishingly beautiful.
Now, thanks to the digital age, we can once again relish in black and
white imagery. Yes, you can use presets in many apps but, with advanced
tools, you can make incredible photos by drilling down and adjusting the
light frequencies and other attributes. (If memory serves, Mr. Adams
used a Red #25 filter to achieve his incredible richness of sky tones.)
The people at Macphun (http://macphun.com) have a collection of tools
that will aid you in reviving this long, lost art. To create amazing b/w
images you’ll want to use Tonality (http://macphun.com/tonality).

Tonality is the most advanced and feature rich black & white image
editor on Mac OS. It imports RAW images and includes a complete set of
darkroom-inspired features for creating amazing fine art monochrome
photos.
To learn how to use all of the various tools, Macphun has a collection of
over a dozen videos they call the “Tonality Learning Lab.” (Have a look
at http://vimeopro.com/macphunfamily/tonalitylearninglab.) Here
you’ll be instructed how to navigate the interface, how to intelligently
use presets, how to properly apply grain, use layers (up to seven) to
enhance your compositions and more. There are fourteen tutorials in all.
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If you’re really only interested in presets, Tonality has your back with 50
presets, all of which are adjustable. You can also mark your favorite
presets by clicking on the star just below it. You can import custom
presets plus create your presets of your own and save them for future
use.
And you’re not limited to one preset per image. By incorporating layers,
you can combine presets. Couple this with your ability to adjust the
presets and you have quite a powerful tool even when using it at its base
level.
Also when you use your presets with layers, the tools that your selected
preset is using will light up on the right hand side of your interface.

Tonality can stand as a separate application or be used professionally as a
plug-in within Photoshop, Lightroom, Photoshop Elements and Aperture.
There’s Authentic film emulation presets, native RAW support with 16bit image processing, support of the most popular image formats from
JPEG to PSD, texture overlays (24 available) with export custom
textures capabilities and over a dozen more high-end features.
When finished, you have the option of exporting your final image to
their print lab for high quality print images.
And has become the norm, you can export to your favorite Social Media
venue all without having to leave Tonality.
Oddly, as I have a degree in Film/Video, you would think that I would
have an extensive library of snaps. But in reality, the converse is the
truth. So, I am learning a lot using this app.
I found the UI very intuitive. The expandable tools are available in the
right sidebar, There’s also several functions/tools located at the top of the
pane. After watching the videos, I opened up a photograph and just
began playing with the various tools to get a real feel for the app’s
capabilities. (You can learn a lot simply pushing buttons.)
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One of the tools that I found most useful as an amateur was the
Navigation Tool. It brings up a small pane that allows you to zoom in
and focus on a specific region of your photograph, enabling you to work
on fine details.
There’s also a Split Screen tool that will bring up ‘before’ and ‘after’
renderings of the project you’re working on side-by-side. As a bonus,
you can arrange the screen to perform your comparison in either portrait
or landscape mode, whichever workflow you prefer.
Tonality has a histogram feature, which to be honest, as a neophyte, I
haven’t completely wrapped my head around as of yet. To really get a
feel for Tonality, watch their training videos several times to understand
using all of the tools in greater detail.
Tonality comes in two versions: Tonality and Tonality Pro. Tonality Pro
provides these advanced features for professionals:
- "Plug-in support for Adobe PS, Lightroom, Apple Aperture.
- "Advanced Layers functionality with Blend Modes
- "The ability to use the source color from the original image
- "8 layers for enhanced creativity
- "Upgraded Vignette with Centering & Luminosity control
- "Zone System to "balance" gray shades for superior contrast
- "Support of additional shortcuts for faster workflow
- "Histograms with tonal range clipping and pixel saturation
- “Smart Object (Photoshop plug-in)”
I encourage you, at the very least, to try the trial of Tonality
(http://macphun.com/getstarted/tonality?product=tonality).
Go and take several photographs or grab a photo from your library
(particularly one that you thought was extremely ordinary) and open it
up in Tonality. Start adjusting it into a black and white image using the
techniques that you have learned.
I guarantee you that you’ll be amazed at the number of hidden gems that
reside in your library. Perhaps you have talent you hadn’t realized!
©2015 Frank Petrie (Reproduced with permission)
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Special offers
Peter Fitchett
Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.

Joe on Tech
Joe On Tech guides, (http://joeontech.net/), help you make the most of
technology. These books, written by best-selling author Joe Kissell, (of
Take Control fame) help you determine the best technological solutions
to common problems, improve your tech skills, and develop a better
relationship with your Mac and other digital tools. Joe On Tech ebooks
are available for immediate download in PDF (best for Macs and iPads),
EPUB (best for iBooks on iOS), and Mobipocket (for Kindle) formats, as
well as paperback.
Apple user group members get a 20% on all Joe On Tech guides.
This offer is ongoing.

OWC
Other World Computing (OWC), (www.macsales.com), has been
providing quality hardware products and support to the computer
industry since1988 and features one of the largest online catalogs of
computer, iPod, iPhone, and iPad enhancement products through its ecommerce portal.
OWC is offering very special discount pricing to Apple user group
members on Mac accessories, parts and external storage, as well as used
Macs of all kinds. You’ll find cables, keyboards, SSDs, Thunderbolt
products and external storage. OWC also sells used iMacs, Mac Pros,
MacBooks and Mac minis – check the website for great prices and
availability. Discounts of up to 50% change monthly.
One of the things OWC is known for is their extensive collection of
how-to videos – videos on how to install a new SSD, add memory, and
many other tasks. It’s generally easier to do than anyone may think.
This offer is ongoing.

Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.
For further specials, see our website.
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Updating to iOS 9
I’m sure that you have heard that Apple has released iOS 9 for your
iPhones and iPads (and yes, your iPod touch as well). If you have
managed to hold off this long before upgrading, then I strongly suggest
that you wait just a little longer - just long enough to fully prepare you
device for the upgrade. And that preparation, of course, is to back up!
Reports are that you do want the upgrade, even older (more matured!)
devices appear to be getting a benefit (your’s may be different, but that
may be what the backup is for). There are a small number of reports of
hiccups during and immediately after the upgrade, but most appear to be
due to servers being overloaded by the demand. In some cases a hang
may occur, but your backup can be used to correct this situation and
complete the upgrade.
Make a backup using iTunes
1. Open iTunes and connect your device to your computer. Check that
iTunes is up-to-date - version 12.3 provided iOS 9 support.
2. Save content that you downloaded from the iTunes Store or App Store
by clicking File > Devices > Transfer Purchases. Then wait for the
transfer to finish.
3. If you want to save Health and Activity data from your iOS device or
Apple Watch, you’ll need to encrypt your backup: Select the box
called Encrypt [device] backup and make a memorable password.
(Write down your password and store it somewhere safe, because
there’s no way to recover your iTunes backups without this password.)
If you don’t need to save your Health and Activity data, you can make
a backup that isn’t encrypted. Just click Back Up Now.
4. After the process ends, you can see if your backup finished
successfully in iTunes Preferences > Devices. You should see the
name of your device with the date and time that iTunes created the
backup. If you encrypted your backup, you should also see lock icon
beside the name of your device.
Make a backup using iCloud
1. Connect your device to a Wi-Fi network.
2. In iOS 8 or later, tap Settings > iCloud > Backup.
3. In iOS 7 or earlier, tap Settings > iCloud > Storage & Backup.
4. Make sure that iCloud Backup is turned on.
5. Tap Back Up Now. Stay connected to your Wi-Fi network until the
process completes.
6. Make sure the backup finished by tapping Settings > iCloud > Storage
> Manage Storage, and then select your device. The backup you just
made should appear in the details with the time and backup size.
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New in iOS 9
There is a new iOS in town, with a fresh font and a bag of nifty tricks
that it has learnt since iPS 8 hit the streets. So let’s have a look:
1. Get public transit directions
If your streets are in New
York, London or other
exotic location (like
China!) Apple Maps now
includes bus, train and
subway schedule
information (with how late
they are!) Also included in
Maps are walking
directions.
2. Read the news
A new news-reading News app features some carefully curated content
from a group of partner publishers, with articles specially formatted for
iOS devices in an easy-to-follow layout.
3. Access iCloud more easily
iOS 9 makes iCloud a little more visible: Go to Settings, iCloud then
iCloud Drive and toggle the switch marked Show on Home Screen to
enable the icon shortcut.
4. Split the screen
Attention iPad owners! You can all take advantage of the Slide Over
feature in iOS 9 that brings in a second app as a sidebar—just slide your
finger in from the right. iPad Air 2 (and iPad Pro) users can also activate
the more advanced Split View by tapping and dragging the Slide Over
border line.
5. Go back quickly
If you look up in the top-left corner of the iOS
9 interface you’ll often see a Back button
there for those times you’re jumping between
apps to check maps or links. It can be a
quicker way of navigating around than
double-tapping on the Home button.
6. Run smarter searches
As Spotlight in iOS 9 learns more about you, it will make smarter search
recommendations—swipe left from the main home screen to test it out.
Your most frequently used contacts, apps, locations and more will be
shown first, but you can keep scrolling down to see further options.
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7. Write on email attachments
If you’ve always wanted to doodle on the attachments your friends and
colleagues send you, then now’s your chance: Look for the Markup
button when you open or press and hold on a particular attachment
(where it appears depends on the file format of the attachment).
8. Take better Notes
Notes is another stock app with a lot of new stuff to show off with iOS 9.
The revamped app lets you add web links, photos, checklists and
drawings to your notes now, and everything can be synced via iCloud.
There are now more formatting options to play around with.
9. Abandon poor wifi connections
The new Wi-Fi Assist feature in iOS 9 lets you hop onto a speedy LTE
connection if the wifi connection you’re using isn’t up to scratch (quite
likely if you’re out and about). Head to Settings then Cellular and tap on
the Wi-Fi Assist toggle switch at the bottom to make use of the feature.
10. Zoom in on your videos
You can now pinch and zoom on your video clips as well as your photos
—go ahead and try it. There’s also a different way of choosing video and
slo-mo recording modes, as long as your device supports them (open up
Settings, tap on Photos & Camera and look under the Camera heading).
11. Get listening faster
Try plugging your headphones into your newly updated iOS 9 device—
notice anything different? Your iPhone, iPod touch or iPad should
show a small icon depicting the music player app you most
recently used, which you launch with a tap (or a slide upwards if
the screen is locked).
12. Add events from your emails
Part of Apple’s new, smarter, more proactive Siri and iOS strategy
involves spotting events in your email messages and automatically
adding them to your calendar. Prompts should appear in both the Mail
and Calendar apps when potential events are spotted.
13. Search through Settings
You’ll notice a new search box at the top of the front screen in Settings:
Enter your query here (e.g. “Bluetooth” and all of the matching options
appear in a list underneath.
14. Block out the ads
Controversially, Safari on iOS now supports mobile ad blockers, so you
can browse the internet at large free from memory-hogging, attentiongrabbing promotions. If you go into the Safari section of Settings, you’ll
see a new Content Blockers option, though you need to install one (or
more) first.
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15. Select multiple photos
iOS 9 lets you select multiple pictures more easily than before. After
you’ve tapped Select in the Photos app, you can tap and drag to pick the
images you want to work with, rather than having to tap on them
individually.
16. Hide photos
While we’re on the topic of pictures, iOS 9 lets you hide more sensitive
material from view as well (just in case your friends grab your iPhone).
On the Share menu you’ll find a handy new Hide option, though images
are still visible (and can be unhidden) through the Albums view inside
the app.
17. Manage battery life
iOS 9 wants to ease your battery life woes with a new low power mode
that you can activate from the Battery menu inside Settings (it switches
off a few background processes and can add up to an hour of life). Your
battery icon turns yellow and you get a percentage view of the juice
that’s left.
18. Add a Find my Friends widget
Find My Friends isn’t a new app but it’s now a stock app that appears on
your iOS device whether you like it or not. It also gains a Notification
Center widget with iOS 9, so you can see where all your pals are right
from the Today page (drag down from the Home screen and tap Edit to
set this up).
19. Call up Siri from anywhere
Previously the voice shortcut, “Hey Siri!”, only worked when your
iPhone was charging, but you can enable it anywhere via Siri under
General in the Settings app. It only works on the latest iPhone 6S and
iPhone 6S Plus handsets though, unfortunately.
20. Turn the keyboard into a trackpad
One of the iOS 9 keyboard changes is the switch to lower case letters
when you’re actually in lower case, which makes sense. What’s more, if
you’re on an iPad, you can turn your touchscreen keyboard into a handy
trackpad simply by pressing and holding two fingers on any of the keys.
21. Find your selfies more easily
Pictures taken with the front-facing camera get their own folder in the
Photos app, enabling you to find them more easily. For the techies out
there, screenshots get their own folder too.
22. Use picture-in-picture
On an iPad, with a supported app (they should all be, given time), you
can take advantage of the picture-in-picture technology: When viewing a
video full-screen, tap the icon in the lower right-hand corner to shrink it.
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El Capitan tips
El Capitan will be let loose onto the world just after our next meeting the next day, so it is getting to be time to start seeing what is coming.
The release includes enhancements to window management, built-in
apps and Spotlight search, and makes everyday activities — from
launching apps to accessing email — faster and more responsive. Metal,
(Apple’s breakthrough graphics technology), is integrated into El
Capitan, delivering system-wide performance gains and enabling games
and pro apps to tap into the full power of Mac graphics processors.
Auto-hide the menubar in OS X El Capitan
OS X El Capitan now makes it possible to auto-hide the menubar that
appears at the top of your Mac’s screen. This helps you make better use
of the screen real estate on your Mac.
Don’t worry though, if you want to see the menubar again, just put your
cursor at the top of your Mac’s screen and the menubar will appear as
usual.
Split View window resizing in OS X El Capitan
OS X El Capitan now comes with Split View window resizing. Split
View makes it easy and fast to put two applications side by side in fullscreen view. This can be a big help if you need to copy and paste text
between applications.
There are two different ways
you can use Split View
window resizing in OS X El
Capitan, using the mouse, or
Mission Control.
Once you have the application windows side by side, you can also resize
them so that one app has more screen space than the other.
When you are done with Split View, just hit the Escape button or click on
the green full-screen button.
Delete files immediately in OS X El Capitan
OS X El Capitan now lets you delete files immediately from your Mac
instead of putting them in the Trash. You can also immediately delete a
file that is already in your Trash.
Here’s how you can immediately delete a file in the Finder using the file
menu or simply use this keyboard command..
Pin sites in Safari in OS X El Capitan
OS X El Capitan now lets you pin your most used Web pages in Safari.
When you pin a site it will appear on the left side in Safari’s tab bar. Your
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pinned sites will refresh in the background, so they stay up to date
automatically.
Mute all tabs in Safari in OS X El Capitan
Who among us has not loaded a Web page only to have an annoying
video or sound play automatically? In the past you’d have to frantically
try to find the tab that the sound was playing in, but in OS X El Capitan
you can easily mute all tabs in Safari.
You can mute all tabs in Safari, mute individual tabs and mute other tabs
while listening to one tab in Safari in OS X El Capitan.
Find your cursor by shaking your mouse or trackpad in OS X El
Capitan
OS X El Capitan now comes with a
fun, easy way to find your cursor
while using your Mac. You can
shake your mouse or trackpad and the
cursor will magnify on your screen so you can quickly
locate it.
Enable the three-finger drag gesture in OS X El Capitan
The three-finger drag gesture in OS X El Capitan can be a big help if you
suffer from carpal tunnel problems since it makes it easier to select and
drag objects on your desktop with just three fingers. And it also lets you
select text with three fingers.
Apple made a change in OS El Capitan that moved the three-finger drag
gesture from the Trackpad menu to the Accessibility menu. This has led
some folks to think that the gesture has been removed but it has just been
moved.
Use a gray background in Safari Reader in OS X El Capitan
Safari Reader is an amazingly helpful tool that makes it much easier to
read Web pages. Safari Reader reformats website pages into a format is
much more pleasing to view. And in OS X El Capitan you can now select
a gray background with white text.

Remember to backup before upgrading to iOS 9
Remember to backup before upgrading to OS X 10.11
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Old email addresses
After using Apple Mail for a few years you may have noticed that, when
adding contacts to a new email message, a long list of email addresses
appears. Some of these may be in your address book, but it’s often the
case that these names are people you haven’t sent messages to in years or
that you emailed once, but have no intention of emailing ever again.
Apple’s Mail app has a feature called Smart Addresses that’s designed to
make it easier for you to see who you’re sending email messages to.
Instead of displaying names and addresses in Mail’s To: field, Smart
Addresses just display the name of the email recipient. One of the
benefits of using Smart Addresses is the option to delete previous
recipients from Mail’s collection of remembered addresses.
(Note: Help for the Mail app claims that the Smart Addresses option
needs to be selected in Mail’s preferences in order for you to delete
previous recipients from the “To:” field. In my experience this is not the
case. Your mileage may vary.)
Smart Addresses is enabled by default, but you can make sure this feature
is on by:
Opening the Mail App.
Selecting the Mail menu and choosing Preferences.
Clicking the Viewing tab.
Checking the box that says Use Smart Addresses.
When you select Smart Addresses, it changes the way Mail displays
addressing information from a full named and address:
To just an addressee’s name:
Once you enter the ancient email address you should note that there’s a
small arrow next to the recipient’s name. Click that menu and included in
the list of menu options you’ll see an item that says, “Remove from
Previous Recipients List.” Select this item and this ancient address will
no longer appear when you address a new email message.
This is a pretty tedious way to have to remove old email addresses and,
thankfully, there’s a way to bypass the tedium.
With Mail open, select the Window menu and choose
Previous Recipients.
This opens a window displaying a list of everyone you’ve sent email
messages to. Take note of the first column. Anyone with a contact card
next to their name is someone who is already in your Contact list,
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nothing in that field means they’re not. To add a previous recipient to
your address book:

Select the recipient.
Click the Add to Contacts button at the bottom-right of the
Previous Recipient’s window.
You should note that this Add to Contacts option does not insert this
email address into the record for an existing contact if one already exists
for the contact you’ve just added. To fix this you’ll need to:
Open the Contacts App
Search for the name of the contact you just added.
If two contacts appear for the contact you added, select
both contacts.
a. Click the first
b. Shift-click the second
Click the Card menu.
Select Merge Selected Cards.
More than likely what you really want to do is remove the many oddball
email addresses collected by the Mail app. For my money the easiest
way to figure out which addresses to get rid of is to sort the list by Last
Used date and delete from the top down:
Open the Previous Recipients window. (Window >
Previous Recipients)
Click the Last Used column header until the oldest date
appears at the top.
Click the first address appearing in the list.
Scroll to the last date you want to delete address for and
shift-click that contact.
Click the Remove From List button.
This will not delete any contacts from the Contacts app, it only keeps
mail from remembering past recipients.
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Around, About
Peter Fitchett
Video producer Adam Matthews wanted to double the number of 4K
monitors hooked up to his Mac Pro, so he built an external GPU to do it.
He used a Sonnet Thunderbolt chassis with an AMD 7970 GPU – before
discovering that the his Mac Pro could actually drive all six monitors
using only the inbuilt twin graphics cards. It seems that Apple has been
conservative in its claims; but I’m sure Adam had fun building his
interface for the 50,000,000 pixel display system.
With the eminent arrival of El Capitan, the upgrades are coming ...
Parallels has released version 11 with different function 15-50% faster.
Its rival, VMware Fusion has released version 8 with new features and
“its relatively consistent performance gains over its predecessor” whatever that means.
A British technology company has claimed a major smartphone
breakthrough by developing an iPhone that can go a week without
recharging, by running off a built-in hydrogen fuel cell. A fuel cell
system into the current iPhone 6 without any alteration to the size or
shape of the device. The only cosmetic differences compared with other
handsets are rear vents so an imperceptible amount of water vapour can
escape. (I would think that an imperceptible vent would be sufficient!)
For the commercial launch the company is developing a disposable
cartridge that would slot into the bottom of future smartphones and
contain enough hydrogen-releasing powder for a week of normal use
without recharging. They are now considering the cartridges’ sale price.
(More than the price of electricity to recharge a normal battery would be
my guess.)
Apple has changed its iCloud pricing: still 5GB free, but price drops for
other plans, up to 1TB for ‘only’ US$9.99/month. Note that external
disks are from NZ$85 for 1TB - less than 6 months of iCloud - and much
faster!
TheSimplest.Net has announced the release of OCR Instantly 1.1, an
update to their app utility developed for iOS and Android devices. This
apps takes an image and converts it into digitized text which can then be
shared to other applications such as Email and SMS, or simply copy
paste the text to anywhere you like.
After the success of Fews -- Your Essential Daily News for mobile
devices (iOS and Android), AppGeneration has just released this Free
media app for Mac. With Fews you can read the best news feeds from
more than 25 countries, from tech blogs to local news, sports, economy
and lifestyle. You can also change to HTML view and read it directly
from the sources website.
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AirServer is pleased to announce that a major update for AirServer,
developed in collaboration with YouTube Live Streaming, is now
available. The updated version brings full compatibility with iOS 9 and
OS X El Capitan, and allows you to stream iOS apps and games to
YouTube Live - including picture-in-picture and retina quality mirroring.
How many times have you wanted to dress up your photos with 3D type?
None? Well with all the horrible photography we're seeing on the web
these days, you'd think someone would like to have something to dress
up that c***! Verba 3D is an all new iOS application for adding
stunning 3D text to photos.
Jony Ive’s latest design upgrades to Apple stores include real trees. This
has provoked a slew of online comments:
- Helpful advice for owners of Apple products is available at the Genius
Hedge
- …at your local Apple branch.
- Or, just call teak support and leaf a message.
A standalone version of Microsoft Office 2016 for Mac has been
released, on the same day Microsoft launches Office 2016 for Windows.
Already available to download for Mac users since July as part of Office
365 suite, today's release is the first time the most recent version of
Office is being offered for purchase on Mac without requiring the
subscription, with both Office Home & Student 2016 and Office Home
& Business 2016 versions being offered. NZ$239, or $119/year. The
standalone version does not include Outlook.
I guess that you have heard that Apple has released a new iteration of
iPhones, the iPads, Apple TVs and Apple Watch-straps (the watch is
unchanged!) Many Wall Street analysts attend ‘the’ event (or watch the
on-line version just like the rest of us - and they are not backward in
letting us know their opinions. Reports indicate some were impressed,
while others were underwhelmed. So that is good, or not-so-good.
The Leef iBridge (http://www.leefco.com) may be the answer to a
couple of our recent prayers. It is an elegant, MFI certified, USB and
Lightning drive solution for Lightning port equipped iPhones
and iPads that allows users to transfer data directly
between a Mac or PC via USB drive to their compatible
iOS device. It supports unprotected video and
music files in the full range of formats
supported by Apple on these devices
(including ALAC) as well as Office-style
document types.
So you have just updated your iPhone / iPad to iOS 9 ... well a new
update is already available - version 9.0.1. Apparently a couple of small
bugs crept into the original release. The second release of iOS 9.1 has
also been released to developers, so even more changes coming. Isn’t
Apple good to you?
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When you are drawling over a new iPhone / iPad (etc), just remember:
"The real issue is value, not price."
Robert T. Lindgren
Wanting some free apps for your Mac? There are several categories
available at http://www.thriftmac.com (but remember that sometiomes
they are worth what you paid for them).
Apple’s discussions support site has always been useful in finding that
stray bit of useful information, but a visit there at present tells you that
the page wasn’t found, and to try the main page of Apple Support
Communities - with the link taking you right back to the same page!
If you are wondering what to do with your pile of old Mac Pro
computers, have a look at
https://projektgalerie.wordpress.com/2014/06/24/mac-g5-moebel/
Yes, it is in German, but you just want to look at the pictures ...
So Apple have included Siri voice control in the new super Apple TV.
Any guesses how long before we see TV programs with “Hey Siri, ...” in
the dialog? Or maybe commercials that start “Hey Siri, turn up the
volume”?
So your life insurance premium is raised if you undertake risky hobbies.
How long before the companies will want to access your health
monitoring info (iPhone, Watch, etc) and charge extra for not meeting
your step targets? (Hint: Swiss insurance provider, CSS!)

SeniorNet Mac
Computer Training Lessons: Two-hour sessions, once a week for four
weeks. Course notes are provided. Classes are small with a maximum of
six students and two tutors per lesson.
Social Events: Held on the fourth Tuesday of the month.
Newsletter: Supplied every two months.
We are now located at: 190 Worcester Str, Christchurch.
Contact: If you would like to join SeniorNet Mac and are in the 55-plus
age group, please contact Allan Rutherford at (03) 352-4950, or email:
ajmr@xtra.co.nz,
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About the user group
Aims

Canterbury Apple Users is a non-profit
subsection of SeniorNet Mac
(Christchurch) that exists for the purpose
of exchanging ideas and expertise about
the use of Apple computers, the Macintosh
operating systems, and related hardware
and software.

Meeting venue
Meetings are held on the last
Wednesday of each month
(except December) beginning at
7:30pm, at the Convention
Centre, corner Highsted and
Sawyers Arms Roads.
Drinks, and maybe a snack, are
available while we all calm
down after the excitement of the
meeting.
If you find it difficult to get to
meetings, please contact an
organizer to see how we can
help.

Group contacts
Website

http://www.appleusers.co.nz

Mailing Lists

Peter Fitchett
listadmin@appleusers.co.nz

(3) 960 8189

The HELP email list is open to all Mac users who
wish to give or receive assistance. See our website
for instruction on how to subscribe/unsubscribe.

